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This presentation covers the RPG and COBOL iSeries specific 
tools (Remote Systems Explorer and iSeries Project perspective) 
within the Development Studio Client workbench or IDE.
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This presentation is a collaborative effort from the very team 
that brings you WDSc!
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This is the new release of WDSc that was announced and shipped in June 2002
WebSphere Development Studio (WDS), as stated, is the overall umbrella product which includes the four host compilers and classic tools (ADTS), and unlimited licenses of the client tools previously known as WebSphere Development Tools for iSeries (WDT)
As stated, WebSphere Development Studio Client 4.0 is the next release of WebSphere Development Tools V5R1
There was no new release of the overall WDS product in June, only the client tools. These are only available for V5R1 or above, although they mostly do work with a V4R5 system
Customers who have WDS are entitled to WDSc for free, but they must order it. This is done by re-ordering WDS and specifying feature code 2655.
The overall WDS product itself is refreshed for V5R2, at which time the four host compilers are updated with new enhancements as is typical for a new release
WDSc is a superset of the WebSphere Studio Site Developer Advanced product (WSSDa). 
As stated previously: WSSDa includes all of the Eclipse support for Team, Projects, User Interface Framework, plugin development and Java development. Further it also adds support for built-in WebSphere Application Server, for Web development, for remote 
application servers, for Web Services, for XML development and for Database development.
To the WSSDa base, WDSc adds support for iSeries projects and exploration of remoteystems, as well as adding iSeries extensions to the Java Tools, Web Tools and Web Services tools. It also includes WebFacing, which builds on the Java and Web tools. All of 
these tools will be briefly described in the following slides.
The classic CODE and VARPG products are also included with WDSc, but not so the classic VisualAge for Java and WebSphere Studio products. These last two have been subsumed by WSSDa and hence WDSc 
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Now we cover the RPG and COBOL tools within the WDSC 
IDE
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Remote Systems ExplorerRemote Systems Explorer

iSeries Tools for RPG and COBOLiSeries Tools for RPG and COBOL

1. Remote Systems Explorer
PDM-like drill-down or filtered access to:PDM-like drill-down or filtered access to:

iSeriesiSeries libraries, objects, members, records, fields libraries, objects, members, records, fields
iSeriesiSeries Jobs Jobs
iSeries IFSiSeries IFS Folders and Files Folders and Files
LinuxLinux (including iSeries  (including iSeries LPARLPAR) Folders and Files) Folders and Files
UnixUnix and  and WindowsWindows Folders and Files Folders and Files
LocalLocal Folders and Files Folders and Files

2. iSeries Projects
Project-based, team-sharable, developmentProject-based, team-sharable, development
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There are two explicit areas of functionality, each with their own perspective, for iSeries programmers
The first area of functionality is the Remote Systems Explorer, which has its own perspective and views
This first area of functionality is similar to PDM in that it allows the developer to drill down into the QSYS file system, or use filters to list specific objects within the QSYS file system
The Remote Systems Explorer goes well beyond PDM however! It also allows exploration of iSeries jobs and commands, and the IFS file system. Further, it can also be used to explore the file system of remote Linux, Unix 
and Windows systems. The Linux support works for any Linux, including Linux in an iSeries Logical Partition.
The second area of functionality is iSeries Projects,  which also has its own perspective and views. 
Unlike the Remote Systems Explorer, an iSeries project fully leverages the Eclipse support for resources. This means an iSeries project contains folders and files that exist in the local file system, yet can be shared and 
synchronized among a team, if an eclipse-compliant repository is used. The options for this today include Rational's ClearCase or the free and open-source product CVS or Concurrent Versioning Systems, or the MKS 
Integrity. CVS is available on the distribution CDs for the Linux LPAR on iSeries. In the near future, the remaining iSeries change management vendors will also be available as repository options.
As you will see, an iSeries project allows RPG and COBOL developers to fully exploit the power Eclipse, while developing applications targeted to run on iSeries.
We will explore each of these tools...
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Remote Systems ExplorerRemote Systems Explorer

1.1. Remote Systems Explorer (Remote Systems Explorer (RSERSE))
A perspective with many views

Remote Systems Remote Systems 
the primary "tree" view for exploringthe primary "tree" view for exploring

Commands Commands 
the view for running and logging commandsthe view for running and logging commands

PropertiesProperties
the view for showing information about selected object(s)the view for showing information about selected object(s)

iSeries Error ListiSeries Error List
the view for showing errors returned by compilersthe view for showing errors returned by compilers

many more views...many more views...
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The Remote System Explorer is an eclipse perspective with many views to help developers work with resources in a remote system
The primary view is the Remote Systems tree view, where remote system resources are explored, similar to the Windows Explorer
There is also a commands view, or shell, for entering commands to be run remotely, and for logging the results of all commands
There is also a Properties view, which is common throughout Eclipse. It shows interesting information about the object currently selected in 
the primary view
There is an iSeries Error List view where errors are shown after performing a remote compile
There are many other views which will appear when requested via popup menu actions



iSeries AD, IBM Toronto iSeries AD, IBM Toronto 
Remote Systems ExplorerRemote Systems Explorer

What is a "connection"?
Information identifying a remote system
Given an arbitrary name 
Contains environment info such as lib list
Used in many WDSc tools 

RSE, iSeries Projects, Java Tools, Web RSE, iSeries Projects, Java Tools, Web 
Tools, WebFacingTools, WebFacing

RSE manages connections
Create connections here (using wizard)
Change, rename, copy, delete them here
Expand them to work with resources here 

RSE: ConnectionsRSE: Connections
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A very central concept to all of WDSc is that of connections.
A connection defines information needed to access a remote system. Each connection is given an arbitrary name by the user, and so multiple 
connections to the same system are permitted
Each connection also captures information that is applied when connecting to that remote system, such as the initial library list for iSeries connections
All iSeries tools within WDSc use connections to access a remote iSeries system
Connections are created and managed in the Remote Systems Explorer
Further, the Remote Systems Explorer is also used to explore objects in a remote system, by expanding a connection
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Remote Systems ExplorerRemote Systems Explorer

New Connection New Connection 
WizardWizard

Arbitrary nameArbitrary name
Remote system type: Remote system type: 

iSeriesiSeries
WindowsWindows
UnixUnix
LinuxLinux
LocalLocal

Host nameHost name
User IDUser ID

Properties of selected objectProperties of selected object Various helper viewsVarious helper views

Remote Remote 
Systems ViewSystems View
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This is the Remote Systems Explorer perspective. This is the first perspective you see when starting WebSphere Development Studio Client for the first time.
The Remote Systems view lists your existing connections, and contains an item that when expanded launches the New Connection wizard for creating a new connection
The New Connection wizard prompts for information about the connection, including an arbitrary but unique name, the type of the remote system, the TCP/IP hostname for 
the system, the User ID to connect to the system with, and optionally a description of the connection
Once created, a connection is listed in the tree and can be expanded to explore the contents of that remote system, which we will describe soon
The Remote Systems Explorer contains other views of interest, including the Properties view in the lower left, and various other views in the lower right that are in a tabbed 
notebook
Like all views in Eclipse, these views can be moved to a different location by dragging and dropping them
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Connection ActionsConnection Actions

Popup Menu for Popup Menu for 
ConnectionsConnections

Rename ConnectionRename Connection
Copy ConnectionCopy Connection
Move ConnectionMove Connection
Delete ConnectionDelete Connection

ReOrder ReOrder 
ConnectionsConnections
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Connections support actions in their popup menu for manipulating them.
These include:
Rename Connection. For giving the connection a new name
Copy Connection. For creating a new connection based on this connection. You will be prompted for a new name. You can also copy a connection to another profile. We will cover profiles later.
Move Connection. For moving a connection to another profile. We will cover profiles later.
Delete Connection. For deleting a connection.
Move Up Connection. For moving the selected connections up in the connection list. 
Move Down Connection. For moving the selected connections down in the connection list.
You can also change the attributes of a connection, such as the host name or user Id, either by selecting the Properties popup menu item, or by editing the attributes in the Properties view (be sure to press 
Enter!) 
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Remote Systems ExplorerRemote Systems Explorer
Connections expand to 

"subsystems"
Named grouping of functionalityNamed grouping of functionality

Subsystems for iSeries:
iSeries Objects 

For working with Libraries, Objects and MembersFor working with Libraries, Objects and Members
iSeries Commands

For pre-defining and running QSYS command sets For pre-defining and running QSYS command sets 
iSeries Jobs

For working with jobsFor working with jobs
IFS Files

For working with Integrated File System filesFor working with Integrated File System files
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Once connections are defined they can be expanded within the Remote Systems Explorer
On expansion, the user sees subsystems, which are merely a functional grouping of the various types of remote resources that can be explored in the remote system
For iSeries connections, there are four subsystems:
 1. iSeries Objects is the PDM-like grouping, allowing access to libraries, objects and members
 2. iSeries Commands allows developers to predefine command sets each of which contain one or more often used commands. When run, all commands in a 
command set are sent to the remote system and executed, and the results are logged in the Commands view
 3. iSeries Jobs allows developers to see various jobs, subsettable by job attributes, and to perform a limited number of operations on those jobs
 4. IFS Files allows developers to explore folders and files in the Integrated File System of the remote iSeries system



iSeries AD, IBM Toronto iSeries AD, IBM Toronto 
Remote Systems ExplorerRemote Systems Explorer
iSeries Commands Properties

Library list Library list 
Current libraryCurrent library
Initial command Initial command 

Tip: you can import CODE Connections!

Use Properties of  Use Properties of  
"iSeries Commands" "iSeries Commands" 

to set connection to set connection 
informationinformation

WDT400 Page (11)

When a connection is used to connect to a remote iSeries, your initial program as specified in your user ID is not honored. You can 
overcome this by using the Properties popup menu item from a selected iSeries Commands subsystem under a connnection. 
On this Properties dialog you can specify libraries to add to the library list, specify a current library, and specify an initial 
command to run. The initial command must not be interactive!
When the connection is used to connect to the iSeries, the RSE will execute the appropriate ADDLIBLE, CHGCURLIB commands, 
and call your initial command. 
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Prompted Prompted 
to signonto signon

iSeries Objects SubSystemiSeries Objects SubSystem

   List libraries on library list   List libraries on library list

iSeries Objects SubSystem
For drill-down or filtered access to QSYS

Create member filterCreate member filter
Create object filterCreate object filter
Create library filterCreate library filter

Expand "Library List"Expand "Library List"

WDT400 Page (12)

We now drill down into the iSeries Objects subsystem. This is the subsystem you will use most often! It is very similar to PDM, in that it allows you to access objects in the QSYS file system, and perform actions on those objects.
The three child items at the top of the list are for creating filters, much like in PDM:
Your libraries... prompts you for a simple or generic library name,  and lists all matching libraries. It is similar to WRKLIBPDM.
Your objects... prompts you for a simple or generic library name and simple or generic object name, as well one or more object type and attribute pairs. It lists all matching objects in all matching libraries. it is similar to 
WRKOBJPDM.
Your members... prompts you for a simple or generic library name, simple or generic file name, and simple or generic member name, as well as one or more member types which can also be generic. It lists all matching members 
in all matching files in all matching libraries. It is similar to WRKMBRPDM. 
Unlike PDM, the filters you create are permanently remembered and displayed in this list for easy re-use. We will have more to say about filters. 
To simulate STRPDM's option 12, you can start with the pre-defined Library list filter, that when expanded lists all libraries in your library list. 
With any filter, once it is expanded you can subsequently expand a library to see all objects in the library, and expand files to see all members in the file.
When you expand your first filter, such as the pre-defined Library List filter, you are prompted for your password and then connected to the remote iSeries. Then, the results of resolving the filter are shown...
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iSeries Objects SubSystemiSeries Objects SubSystem

"Library list" is only pre-defined filter

Lists libraries in *LIBLLists libraries in *LIBL

   Icon changes when "connected"   Icon changes when "connected"

Library Library 
popup popup 
menumenu

Expand a Expand a 
librarylibrary
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When you are connected to the remote iSeries, the icons for the connection and its subsystems change to include a small green arrow, so as to indicate the connection 
status.
When the pre-defined library list filter is expanded, and the connection is successful, you will see the libraries on your library list. 
For each library, you can right-click and select from a number of useful actions. There is an action to create a new source file within the selected library, to refresh the 
contents of the library if it is expanded, to rename the library, copy the library or delete the library. These last three actions remotely run the appropriate iSeries command and 
you will see it logged in the Commands view. There are also actions to open a multiple-column table view showing the contents of the library, similar again to PDM. There 
are two levels of details to choose from for the table: Basic and Extra. Extra includes additional columns of information, but will take a bit longer to present.
If you expand a library, you will see all the objects in that library... 
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iSeries Objects SubSystemiSeries Objects SubSystem

Expanding a library lists all objects

Src File Src File 
popup popup 
menumenu

Expanding a library Expanding a library 
lists all objects in the lists all objects in the 

librarylibrary

Expand a Expand a 
source filesource file
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When a library is expanded in the Remote Systems tree view, all the objects within that library are listed underneath the library. 
For each object, you can right-click and select from a number of useful actions. The exact list of actions will depend on the type of object you select, and whether 
you selected one or multiple objects. 
For a source file, the popup menu has an action to create a new member within the selected file, to refresh the contents of the file if it is expanded, to rename the 
file, copy the file, move the file and delete the file. These actions remotely run the appropriate iSeries command and you will see it logged in the Commands 
view. For both data and source files, there are also actions to open a multiple-column table view showing the contents of the file. You can choose to list the 
members, similar to PDM, or list the fields. 
If you expand a file, you will see all the members in that file... 
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iSeries Objects SubSystemiSeries Objects SubSystem

Expanding a src file lists all members

Expanding a DB file Expanding a DB file 
lists all members in lists all members in 

the filethe file
Src Member Src Member 
popup menupopup menu
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When a data or source file is expanded in the Remote Systems tree view, all the members within that file are listed 
underneath the file. 
For each member, you can right-click and select from a number of useful actions. The exact list of actions will depend 
on whether the member is a data file or a source, and whether you selected one or multiple members. 
For a source file, the popup menu hasctions for editing, renaming, copying, moving, deleting and compiling the source 
member. We will have more to say about the editing and compiling actions in the next slides...
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iSeries Objects SubSystemiSeries Objects SubSystem

Src Member Src Member 
popup menupopup menu

Launch built-in Lpex editorLaunch built-in Lpex editor
Launch external CODE editorLaunch external CODE editor

Source Member Edit ActionsSource Member Edit Actions

WDT400 Page (16)

For a source member, there are two options for editing: 
1. Lpex Editor. This is the new editor, written all in Java, that is built-in to the IDE. It is a re-write of the original CODE 
Editor, but as you will see has a subset of the functionality in CODE at this point.
2. CODE Editor. This is the classic full-functioned CODE editor, which is offered as an alternative until the Lpex editor 
catches up to the functionality of the CODE editor. This launches the CODE Editor in a separate window.
We will cover the Lpex editor next in a bit more detail...
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EditingEditing

Lpex ("JLpex") built-in IDE editor
Tab for each Tab for each 

open mbropen mbr

Built-in prompter Built-in prompter 
viewview

insert / replace insert / replace 
toggletoggle

F4F4
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The Lpex editor is built-in, so it shows up in a pane within the IDE.
You can open multiple members for editing, and each will be shown in the editor area with a tab that when selected brings that member to the 
foreground.
You can double click on a tab to expand that member's edit window to full size.
When a tab shows an asterisk in it, that indicates there are pending changes that should be saved.
For RPG (both III and IV) you will notice there is color highlighting and familiar F4 support to prompt for the current line. The prompter sits is a view 
that doesn't overlap the editor. When done filling in the prompt, you can press one of two buttons to replace the current line or insert a new line.
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LPEX Editor ActionsLPEX Editor Actions

Popup menu within Popup menu within 
Lpex editorLpex editor

clipboard actionsclipboard actions

selection actionsselection actions

include / exclude actionsinclude / exclude actions

show dates show dates 
in prefix in prefix 

areaarea
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Here we see the popup menu within the Lpex editor
The editor is rich with function, and is iSeries-aware!
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LPEX Editor ActionsLPEX Editor Actions

Edit Menu when Lpex Edit Menu when Lpex 
editor has focuseditor has focus

Find and filter Find and filter 
actionsactions

Selection Selection 
actionsactions

ToolsTools

Compares two members visuallyCompares two members visually

Records keystrokes for repetitive tasksRecords keystrokes for repetitive tasks
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Here we see the Edit pulldown menu when the Lpex editor is in focus.
There are even more editor actions here, and there are a handful in the toolbar as well.
The editor tools include a compare utility to visually compare and merge source members, 
and a keystroke recorder to record and playback keystrokes for repetitive tasks.



iSeries AD, IBM Toronto iSeries AD, IBM Toronto 
LPEX vs CODE EditorLPEX vs CODE Editor

Lpex Editor
Re-write of CODE Editor for Eclipse

What it has today:
All base support from CODE Editor, such as:

Alt+L/C/M/D/U/S/J to select/copy/move/delete/unselect/split/joinAlt+L/C/M/D/U/S/J to select/copy/move/delete/unselect/split/join
Select streams, lines, blocks and rectangles (Edit menu)Select streams, lines, blocks and rectangles (Edit menu)
Command-line for directly entering editor commandsCommand-line for directly entering editor commands
Keystroke recording for repetitive tasksKeystroke recording for repetitive tasks
Compare utilityCompare utility
Rich search, find and replaceRich search, find and replace
Bookmarks and quick marksBookmarks and quick marks
Ctrl+L to locate a lineCtrl+L to locate a line
Line-number and datestamp maintenance + prefix areaLine-number and datestamp maintenance + prefix area
File->Get File to import a file File->Get File to import a file 
Filter Selection to only show lines containing selected textFilter Selection to only show lines containing selected text
PrintingPrinting
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The Lpex editor in WDSc is a Java rewrite of the classic CODE editor that is written in C++.
The CODE editor has 10 years of evolution behind it, and not all of its functionality is 
available in Lpex today. 
However, the Lpex editor still does have a rich base of function, as shown here 
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LPEX vs CODE EditorLPEX vs CODE Editor

Lpex iSeries Support
Color highlighting for RPG, COBOL, CL, DDSColor highlighting for RPG, COBOL, CL, DDS
Maintenance of 12-byte line number and datestampMaintenance of 12-byte line number and datestamp
F4 PromptingF4 Prompting
SEU prefix area commands (eg I, II, D, DD)SEU prefix area commands (eg I, II, D, DD)
RPG/DDS rulerRPG/DDS ruler

What is yet to come:
REXX macros (Java macros are supported)
Outline View support
F1 context sensitive help 

but all reference manuals are available in Help perspectivebut all reference manuals are available in Help perspective
Syntax checking and Program Verify
Miscellaneous CODE tools and extensions

RPG SmartGuides, Field Reference tool, Navigator Tool, Zoom... RPG SmartGuides, Field Reference tool, Navigator Tool, Zoom... 
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In addition to the base editor function, there is additional support for each programming language 
supported by the editor. 
The language-specific functionality currently available in Lpex is listed here.
However, there is still a number of functions in the CODE editor that are yet to come in Lpex. 
These too are listed here. Many of these will come in the next release.
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iSeries Objects SubSystemiSeries Objects SubSystem

Src Member Src Member 
popup menupopup menu

Compile using typical commandCompile using typical command
Compile using your pre-defined Compile using your pre-defined 

commandcommand
Create your own pre-defined Create your own pre-defined 

commandcommand

Source Member Compile ActionsSource Member Compile Actions
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For a source member, there are two primary options for compiling:
1. Compile (prompt). This runs the selected compile command, and prompts you for parameters.
2. Compile (No Prompt). The runs the selected compile command, without prompting for the parameters.
IBM pre-supplies some compile commands specific for the member type, or you can identify your own 
commands to use see and use, per member type 



iSeries AD, IBM Toronto iSeries AD, IBM Toronto 
iSeries Objects SubSystemiSeries Objects SubSystem

Compile With PromptCompile With Prompt
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When you select to prompt the compile command, the 
command prompt is converted to a GUI and displayed 
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iSeries Objects SubSystemiSeries Objects SubSystem

Work With Work With 
Compile Compile 

CommandsCommands

If these checkboxes not If these checkboxes not 
selected, you must use selected, you must use OOther... ther... 

to select command to select command 

Select Select 
member type member type 

to scope to scope 
command tocommand to

Enter Enter 
compile compile 

command command 
stringstring
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To create your own compile actions, select the Work With Commands menu item from the cascading compile menu in the popup menu for a source 
member.
Here, use the Add or Duplicate buttons to create the commands you want. These may be totally different commands, or the same commands but 
with different parameters.
When adding new commands, be sure to select the member type to scope it to. It will only show up in the compile menu for members of this type. 
You can elect to have these commands show up in the compile menus. If you choose not to, then you must use Other... to select the command at 
compile time
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iSeries Objects SubSystemiSeries Objects SubSystem

Other...Other...

Select member type to see Select member type to see 
available commands foravailable commands for

Select command to Select command to 
runrun
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You use Other... to reach commands not in the compile menu.
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CompilingCompiling

Compile Action...

Compile errors Compile errors 
shown in iSeries shown in iSeries 
Error List viewError List view

Double Double 
click on click on 

errorerror

Filter Filter 
errors by errors by 
severityseverity
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When you select the compile command to run, the command is submitted to batch (you can change this via 
Windows->Preferences).
When the compile is done, there errors are returned and displayed in the iSeries Error List view.
You can double-click on an error to position you in the editor at the line of code causing the error. The error message is also 
inserted under that line, for context.
The iSeries Error List view has a pulldown menu to the right of its title bar that can be used to filter out messages by severity.
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Actions on QSYS ObjectsActions on QSYS Objects
Pre-defined right-click actions

Common actions
Rename, Delete, Copy, Move, PropertiesRename, Delete, Copy, Move, Properties
Rename checks for name uniqueness as you type!Rename checks for name uniqueness as you type!

Library actions
Create Source Physical FileCreate Source Physical File
Show in table (Basic or Extra)Show in table (Basic or Extra)

Program actions
Run (normal, batch, interactive)Run (normal, batch, interactive)
DebugDebug
UpdateUpdate

Module actions
Create Program, Service ProgramCreate Program, Service Program
Update Program, Service ProgramUpdate Program, Service Program

Data and Source Physical File actions
Show in table (Members or Fields)Show in table (Members or Fields) ...continued...
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At this point, a number of the popup menu actions have been shown.
This slide summarizes the popup menu actions for remote libraries 
and objects.
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Actions on QSYS ObjectsActions on QSYS Objects
Pre-defined right-click actions

Display and Printer File actions
Show in Table (fields)Show in Table (fields)

Member actions
Open with->Lpex Editor, CODE Editor, CODE Open with->Lpex Editor, CODE Editor, CODE 
DesignerDesigner
Compile (with and without prompt)Compile (with and without prompt)

Can specify what compile command to execute per member typeCan specify what compile command to execute per member type
Compilers errors displayed in iSeries Error List viewCompilers errors displayed in iSeries Error List view

Double click on error to position editor at offending lineDouble click on error to position editor at offending line

Job actions
End (Immediate or Controlled)End (Immediate or Controlled)
HoldHold
ReleaseRelease
Display Job LogDisplay Job Log
PropertiesProperties
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This slide summarizes the popup menu actions for remote 
device files, members and jobs (when using the iSeries Jobs 
subsystem).
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Objects: Objects: 
BasicBasic

Table ViewsTable Views

Objects: Objects: 
ExtraExtra

Table ViewsTable Views
Columner viewsColumner views
Sortable by columnSortable by column

FieldsFields

MembersMembers
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For libraries and files we can use a popup menu action to open table views to see the contents of the library or file.
Here we see what those views look like. 
In all these table, the columns are attributes for the object or member in each row. The table can be sorted by an 
attribute by simply clicking on the column heading.
The first two tables are listing library contents, first in Basic mode and then in Extra mode. 
The third table is listing members in a database file, and the fourth table is listing fields in a device file or record format.
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User Defined ActionsUser Defined Actions

User-Defined Actions (like PDM!)
Right-click on iSeries Objects

Work With File TypesWork With File Types
Create named types to scope actions against Create named types to scope actions against 
Eg. "RPG" might be RPG + RPGLE + SQLRPGLEEg. "RPG" might be RPG + RPGLE + SQLRPGLE

Work With ActionsWork With Actions
Create, delete or change user-defined actionsCreate, delete or change user-defined actions
Scope them by File TypeScope them by File Type

Tip: you can import CPO Actions!

RSE: User ActionsRSE: User Actions
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While IBM supplies a number of useful actions for remote iSeries objects, it is not possible to supply them all.
Like PDM, you can easily define your own actions. 
To create your own actions, use the Work With actions in the popup menu for iSeries Objects.
These user-defined actions will appear in the popup menus for remote resources. To avoid seeing all actions in all popup menus, you scope each action to a 
one or more object or member types.
You first define named collections of object or member types, then you create your actions and scope them to one of these named collections of types. You 
actions will then only appear for object or members that match one of the types in the collection. 
If you are a CODE user, you can use File->Import to import existing actions from CODE Project Organizer.
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File TypesFile Types
Named collection of Named collection of 
scalar or generic scalar or generic 
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IBM and IBM and 
user-defined typesuser-defined types
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arbitrary namearbitrary name
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To define named collections of types for action scoping, use the Work With -> File Types popup menu action for the iSeries Objects 
subsystem.
Select New... to define a new collection: give the collection a name and type in one or more simple or generic types. 
There are two types of named collections: one for objects and one for members.
Once you have defined a type, it shows up in the dialog, and can be edited by simply selecting it on the left, and changig the information on 
the right.
There are many pre-defined types supplied by IBM 
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Once you have defined a type to scope your action by, use Work With -> User Actions to define an object or member action. 
Object actions only appear in the popup menus for libraries or objects.
Member actions only appear in the popup menus for members.
When you define the action, you initially specify a label to show in the popup menu and a non-interactive iSeries command to 
run when that action is selected. This command can use substitution variables that are identical to those in PDM.
After defining the command, select it in the list and select one or more types to scope it by. 
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Once your action is defined, you can use it.
Right click on an object matching one of the types you specified, and expand the User Actions menu in the popup.
Your action appears in the menu. Select it. If you chose to prompt the command, you will see the GUI prompt for the 
command. 
When the command has finished running, it results are logged in the Commands view.
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Expand a subsystem to see "filters"
Like WRKXXXPDM generic name filters but

Are named and savedAre named and saved
There are some predefined

Such as Library List to see *LIBL libraries in iSeries ObjectsSuch as Library List to see *LIBL libraries in iSeries Objects
Such as popular commands in iSeries CommandsSuch as popular commands in iSeries Commands

To create your own, right click on subsystem 
object

Or select "Your XXXX..."Or select "Your XXXX..."
Each filter can contain multiple filter strings

So you can list all libraries that start with A So you can list all libraries that start with A andand B B

RSE: FiltersRSE: Filters
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The Library List filter IBM supplies is useful, but it won't be long before you want to create your own filter to subset the list for performance and 
productivity reasons.
Filters in RSE are like WRKXXXPDM commands in that you specify simple or generic names, and object or member type criteria, to generate a 
subsetted list. Unlike PDM however, the filters in RSE are saved between sessions, so you need only specify the filtering criteria once.
All filters in RSE are named collections of filter strings. It is the filter strings themselves that hold the filtering criteria. By allowing multiple filter 
strings for each filter, you can complete flexibility in what objects are shown when that filter is expanded. For example, sometimes you cannot 
use a single generic name to capture all the objects or members for a particular task. 
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Library filters
Specify simple, generic or special library namesSpecify simple, generic or special library names

Library name can be simple, generic or specialLibrary name can be simple, generic or special

Object filters
Specify simple / generic object names, lib-qualifiedSpecify simple / generic object names, lib-qualified

Library name can be simple, generic or specialLibrary name can be simple, generic or special
Object name can be simple or genericObject name can be simple or generic

Specify simple / generic object types and attributesSpecify simple / generic object types and attributes
Can specify one or more type:attribute pairs (OR operation)Can specify one or more type:attribute pairs (OR operation)

Member filters
Specify simple / generic mbr names, lib/file-qual'fdSpecify simple / generic mbr names, lib/file-qual'fd
Specify simple / generic member typesSpecify simple / generic member types

Can specify one or more member types (OR operation) Can specify one or more member types (OR operation) 

Tip: you can import CPO Filters!
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There are three types of filters you can create in the iSeries Objects subsystem.
1. Library filters. These list libraries when expanded.
2. Object filters. These list objects when expanded.
3. Member filters. These list members when expanded.
We will see an example of creating each of these.
If you are an existing CODE user, you can use File->Import to import filters from CODE Project Organizer.
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Library Filters
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named and named and 
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Results are OR ' dResults are OR ' d

Specify simple, Specify simple, 
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1.Expand1.Expand
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Here we use the Your libraries... prompt to create a library filter. This prompt creates a filter, and then 
immediately expands it for you. Alternatively, you can also right click on the iSeries Objects subsystem and use a 
popup menu action to create a new library filter.
To create a library filter, type in a name to give the filter. This is what will appear in the tree under iSeries Objects.
Press Add... once or more to add library filter strings. Each is a simple or generic library name.
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Expanding Library Filters

Filter created. When Filter created. When 
expanded, lists all libs expanded, lists all libs 
matching filter string(s) matching filter string(s) 

criteriacriteria
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When a library filter is created, it shows up in the list of existing filters for iSeries Objects. 
You can edit the filter by right clicking on it and selecting the Change... action from its popup menu.
When a library filter is expanded, all libraries matching one or more of the filter's filter strings are 
listed underneath the filter.
Note that these libraries can subsequently be expanded, just as they can for the Library List filter. 
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Object Filters

ExpandExpand

Specify simple, Specify simple, 
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library namelibrary name
Specify simple or Specify simple or 

generic object generic object 
namename

Optionally Optionally 
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object type object type 
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Here we use the Your Objects... prompt to create a library filter. This prompt creates a filter, and then immediately expands it for you. 
Alternatively, you can also right click on the iSeries Objects subsystem and use a popup menu action to create a new object filter.
To create an object filter, type in a name to give the filter. This is what will appear in the tree under iSeries Objects.
Press Add... once or more to add object filter strings. 
Each object filter string identifies objects to list. The library and object name can be simple or generic. 
To further subset the list to only objects of particular types or attributes, press Add... from the filter string wizard...
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Object Filters: Filtering by type+attr

All objects meeting All objects meeting 
any of the type:attr any of the type:attr 

filters are listedfilters are listed

Select from lists or Select from lists or 
type in simple or type in simple or 
generic type and generic type and 

attributeattribute

44

WDT400 Page (39)

The Add button in the Object Filter String wizard allows you to specify one or more object type and object attribute 
pairs. The object type can be any valid iSeries object type. The object attribute can be * to match on all objects of 
that type, or a simple or generic attribute to restrict to only objects of that type that match the attribute. 
You can add as many object type and attribute pairs as you need to refine your list. All objects that match on any 
of these type and attribute pairs will be listed, when the filter is expanded.
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Expanding Object Filters

Filter created. When Filter created. When 
expanded, lists all objects expanded, lists all objects 

matching filter string(s) matching filter string(s) 
criteriacriteria
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When an object filter is created, it shows up in the list of existing filters for iSeries Objects. 
You can edit the filter by right clicking on it and selecting the Change... action from its popup menu.
When an object filter is expanded, all objects matching one or more of the filter's filter strings are listed underneath 
the filter.
Note that these objects can subsequently be expanded, if they are files, just as they can from the Library List filter. 
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ExpandExpand
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Here we use the Your Members... prompt to create a member filter. This prompt creates a filter, and then immediately expands it for you. 
Alternatively, you can also right click on the iSeries Objects subsystem and use a popup menu action to create a new member filter.
To create a member filter, type in a name to give the filter. This is what will appear in the tree under iSeries Objects.
Press Add... once or more to add member filter strings. 
Each member filter string identifies members to list. The library, file and member name can be simple or generic. 
To further subset the list to only members of particular types press Add... from the filter string wizard...
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All members meeting All members meeting 
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The Add button in the Member Filter String wizard allows you to specify one or more member 
types. Each member type can be a simple member type, or a generic member type as in RPG*.
You can add as many member types as you need to refine your list. All members that match on 
any of these type will be listed, when the filter is expanded.
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Expanding Member Filters

Filter created. When Filter created. When 
expanded, lists all members expanded, lists all members 

matching filter string(s) matching filter string(s) 
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When a member filter is created, it shows up in the list of existing filters for iSeries Objects. 
You can edit the filter by right clicking on it and selecting the Change... action from its popup 
menu.
When a member filter is expanded, all members matching one or more of the filter's filter strings 
are listed underneath the filter.
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Eventually, you'll have too many filters
Time to turn on "Show Filter Pools" via 
preferences or pulldown in RSE title bar

Expanding subsystems will then first show filter poolsExpanding subsystems will then first show filter pools
Filters are grouped into named pools

By default they are added to the single default filter By default they are added to the single default filter 
pool named Default Filter Poolpool named Default Filter Pool

You can create your own filter pools
Then add filters to itThen add filters to it
Expand a filter pool to see just the filters in itExpand a filter pool to see just the filters in it

Filters pools group filters
Group by project, release, connection, task, etc etcGroup by project, release, connection, task, etc etc

RSE: Filter PoolsRSE: Filter Pools
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There is an advanced feature in the RSE for partitioning filters into named collections, called filter pools.
To enable this, you must select the "Show Filter Pools" preference
Actually, all filters are contained in a filter pool. By default, they all go into one IBM supplied filter pool, named Default Filter Pool.
By turning on the Show Filter Pools preference, you will see these filter pools when you expand a subsystem. When you expand a 
filter pool, you will then see the filters.
Filter pools can be used to effectively group filters by task, or project, or release, or developer, or whatever you like.
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Filter pools are shared
Subsystem don't "contain" filters!

They "contain" They "contain" referencesreferences to filter pools to filter pools
All filters in all referenced pools are shown in listAll filters in all referenced pools are shown in list
All subsystems reference a default pool initiallyAll subsystems reference a default pool initially
Changes to a pool's contents are reflected in all Changes to a pool's contents are reflected in all 
subsystems that reference that filter poolsubsystems that reference that filter pool

Filter Pool 2Filter Pool 2
Filter 1 Filter 2 Filter 3

Connection 1Connection 1
iSeries Objects SubSystemiSeries Objects SubSystem

Connection 2Connection 2
iSeries Objects SubSystemiSeries Objects SubSystem

Filter Pool 1Filter Pool 1
Filter 1 Filter 2 Filter 3

Default Filter PoolDefault Filter Pool
Filter 1 Filter 2 Filter 3references
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Subsystems within each connection do not actually contain filter pools per se. They contain references to filter pools.
Every connection you create is supplied with a single reference to the default filter pool.
You can easily add references to other filter pools for any connection.
When filters are added, changed or deleted within a filter pool,  these changes are reflected in all connections that reference the filter pool. Or more accurately, 
these changes are reflected in the subsystem that references the filter pool within all connections. It is important to know that each connection has a unique 
subsystem instance. 
The diagram shows two connections and three filter pools. The first connection contains only the IBM supplied reference to the default filter pool. The second 
connection also contains a reference to another filter pool. Filters in Filter Pool 2 only appear for Connection 2 in this example.
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Why share filter pools?
1. Filters shared across connections

Filter created in connection A can be re-used in Filter created in connection A can be re-used in 
connection Bconnection B

By placing the filter in a filter pool shared by both connectionsBy placing the filter in a filter pool shared by both connections

2. Filters private per connection
Create a unique filter pool per connection if sharing not Create a unique filter pool per connection if sharing not 
desireddesired

3. Filters both shared and private per connection
Some filter pools can be private, some sharedSome filter pools can be private, some shared
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There are good reasons for storing filter pool references, versus actual filter pools, within each connection.
Consider creating a connection, then adding a number of filters to it:
If you delete the connection, would you expect the filters to be deleted too? 
If you create a second connection, would you expect to be able to see the filters from the first connection? 
If you do see the filters in two connections, if you change a filter in one connection, do you expect it to be changed in the other connection?
By using filter pools and filter pool references, we get the most flexibility:
1. You can share filters across connections by referencing the same pool in multiple connections.
2. You can have filters unique to a connection by having a unique filter pool only referenced by that connection
3. You can choose to reference multiple filter pools in one connection, so some filters can be shared between connections while others are unique to a connection. This is most powerful when used with team support that we describe later.
In all cases, there is only a single copy of each filter, and when changed all connections referencing its parent filter pool see that change.
Filters are never deleted implicitly, for example when a connection is deleted. You must explicitly delete the filter, or its filter pool.  
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"Show Filter Pools" "Show Filter Pools" 
changes RSE changes RSE 
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filter pools underneath filter pools underneath 

subsystems subsystems 

Filter pools shown Filter pools shown 
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Filters shown under Filters shown under 
filter poolsfilter pools
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Here we see how to turn on the Show Filter Pools preference. 
Once enabled, when a subsystem is expanded you see not the filters, but first 
the filter pools referenced by this subsystem in this connection. 
When a filter pool is expanded, then you see the filters within that filter pool. 
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To create a new filter pool, right click on the subsystem, then select New -> Filter Pool...
All you need to specify for your new filter pool is a unique name. This is what you see when the subsystem is 
expanded. Never mind the Profile prompt for now, we will explain that later. It is defaulted so you need not think about 
it.
When Finish is pressed, the filter pool is created, AND a reference to it is added to this subsystem in this connection.
No other connection has a reference to this new filter pool yet!
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To enable another connection to see the filters we will add to this new filter pool, you must explicitly add a reference to this 
filter pool in that other connection.
Right click on the iSeries Objects subsystem for the other connection, and select the New -> Filter Pool Reference menu. 
Select the filter pool, within the profile it was created in (by default it will be the profile with your workstation's hostname).
Once a reference is added, this pool will now show up under the subsystem for this other connection too.
Now let's add some filters to this new filter pool... 
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To populate a filter pool with filters, right click on it and select New->XXX Filter..., choosing the type of filter you 
want to create.
The New Filter wizard you get is the same as we already described for the Your Libraries, Your Objects and 
Your Members prompts. Those are simply shortcuts to these menu items.
As you create filters in the filter pool, they appear in the RSE tree underneatch each reference to this filter pool. 
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Popup menu actions for filters:
Update parent filter pool that contains the filter
Reflected in all subsystems that reference pool

Filter actionsFilter actions

Edit filterEdit filter
Rename filterRename filter
Copy filter to Copy filter to 

another filter poolanother filter pool
Move filter to Move filter to 

another filter poolanother filter pool
Delete filterDelete filter

Reorder filtersReorder filters

WDT400 Page (51)

You can do much with filters by using the right click popup menu.
For example, you can edit, rename, copy, move, delete and reorder filters. 
All these actions affect the parent filter pool for the selected filters, and all 
references to that filter pool will be updated automatically to reflect the changes. 



iSeries AD, IBM Toronto iSeries AD, IBM Toronto 
ProfilesProfiles

The RSE is designed for team sharing
of connections
of filter pools
of user-defined actions

Team sharing is enabled via profiles
All connections, filter pools, user actions are 
scoped per profile

Each profile is a folder within the RSE projectEach profile is a folder within the RSE project
All data stored within subfoldersAll data stored within subfolders

When RSE project is team-synched
All out-going changes sent to team repositoryAll out-going changes sent to team repository
All in-coming changes received from team repositoryAll in-coming changes received from team repository

RSE: ProfilesRSE: Profiles
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We see that with the RSE you will be creating connections, filter pools, user defined actions and compile commands.
In a team environment, we might wish to share some or all of this information to save the effort of each team member having to redundantly create them. This is especially for team 
members working on a shared task, such as mainenance of an application.
The RSE leverages the Eclipse team support to enable this.
The first order of business for effectively enable team support is to allow delineation between "team" information and "private" information per developer. 
The RSE enables this by using profiles. Every bit of information you create in the RSE is owned by a specific profile, and each developer decides which profiles they wish to see the 
information of.
Team sharing is done using the Eclipse team support, which uses a central repository, and a "synchronize" action to synchronize individual developer's information with the 
repository.  
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All persistent data in the RSE is stored in an 
Eclipse project "under the covers"

Project is named RemoteSystemsConnections
Visible in Eclipse-supplied Navigator viewVisible in Eclipse-supplied Navigator view

This project is team-sharable by the common Eclipse 
team support for projects

Using the Navigator viewUsing the Navigator view
Or using Team cascading menu of the RSE pulldownOr using Team cascading menu of the RSE pulldown

Identify team Identify team 
repositoryrepository

Synchronize with Synchronize with 
team repositoryteam repository
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The RSE uses a single Eclipse project to hold all of the data created within it by a user.
This project inherits the team support that all Eclipse projects have, which includes the 
ability to be associated with a central repository (Team->Properties) and to 
synchronized with that repository (Team->Synchronize with Stream). 
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Navigator viewNavigator view

RSE ProjectRSE Project

"coulthar" profile folder"coulthar" profile folder

"farr" profile folder"farr" profile folder
"team" profile folder"team" profile folder

all connections defined for profile coultharall connections defined for profile coulthar
all filter pools defined for profile coultharall filter pools defined for profile coulthar

all user actions defined for profile coultharall user actions defined for profile coulthar
all compile commands for profile coultharall compile commands for profile coulthar
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While you should never have to do this, you can get an understanding of where the RSE stores the information 
you create in it, by switching to the Eclipse-supplied navigator view and exploring this 
RemoteSystemsConnections project.
The most important thing to notice is that the primary folders in the project are the profile folders, and everything 
else is scoped underneatch those, including connections, filter pools, user actions and compile commands.
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Here we see pictorially how a central repository relates to each developer's IDE, with 
respect to the RSE information the team will share.
You should notice that every developer actually has all the information for every profile 
within the team, when team support is used. We will see why this is and how it is handled... 
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After a team-synch on the RSE project, a 
developer's IDE will have all the profiles for 
the whole team

However, they only see connections, filter pools and 
user defined actions for their "active" profiles

By default, the "team" and the user's private profile are 
the only active profiles

So developer only sees all connections, filter pools and user actions So developer only sees all connections, filter pools and user actions 
that are in the team and developer-unique profilesthat are in the team and developer-unique profiles

It is easy to make addition profiles active
Use the menu items in the RSE title bar pulldown menu Use the menu items in the RSE title bar pulldown menu 
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Because a team-synchronize action copies all the contents of the project from the central repository to the target developer's IDE (and vice 
versa), after such an action the developer will have all the profiles for all his team members in his/her IDE.
This could be overwhelming to see connections and filter pools and user actions and compile commands for the whole team.
So, by default the RSE only shows a subset of these. It shows only the information for those profiles which are "active", which by default is 
the "team" profile and the unique profile for that developer.
Should there be a desire to see information from other profiles, this is easily enabled by making those profiles active too. We will see how to 
do this...
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qualified by profile qualified by profile 
namename
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The pulldown menu from the title bar of the Remote Systems view contains all the profile menu actions. 
From here, you can choose which profiles are active, and you can create, rename, copy and delete profiles.
A very important preference setting in this menu is "Qualify Connection Names". When toggled on, this 
changes the Remote Systems view to show each connection prefixed by the profile it comes from. This can 
be handy when working with both shared and private connections.
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Here we see how active profiles keep team members from being flooded with the information from 
all other team members. 
While each workstation has all the connections, filter pools, user actions and compile commands 
for all team members, by default each developer only sees their own and those that were created 
in the team profile and hence intended to be seen and shared by all. 
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1. Team-shared connections and filter pools
So everyone on the team sees common connections for with common library So everyone on the team sees common connections for with common library 
list, environment settings and filter poolslist, environment settings and filter pools

For common development work. Eg: define profiles such as "team", "fix For common development work. Eg: define profiles such as "team", "fix 
team", "project1 team", "release 1", "emergency fix", etc,etcteam", "project1 team", "release 1", "emergency fix", etc,etc

Ask each team member to make these profiles activeAsk each team member to make these profiles active

2. Developer-unique connections and filter pools
So developers can have connections with unique library list, evironment So developers can have connections with unique library list, evironment 
settings and filter poolssettings and filter pools

For developer-unique work via their unique profilesFor developer-unique work via their unique profiles
Each such private profile only made active by one developerEach such private profile only made active by one developer

3. Team-shared and developer-unique 
Each developers "sees" connections and filter pools from both shared and Each developers "sees" connections and filter pools from both shared and 
private profiles: whatever is "active"private profiles: whatever is "active"

4. Roaming developer
On PC 1: Developer synchronizes with team repositoryOn PC 1: Developer synchronizes with team repository

Sends all connections, filter pools, actions to repositorySends all connections, filter pools, actions to repository
On PC 2: Developer synchronizes RSE with team repositoryOn PC 2: Developer synchronizes RSE with team repository

Gets all connections, filter pools, actions from repositoryGets all connections, filter pools, actions from repository
Makes his profile "active" Makes his profile "active" 
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There are many good reasons for the use of profiles within the Remote Systems explorer, which can be netted 
out to:
a. They allow developers to see both team-shared and private information, combined as one set of information.
b. They allow developers to roam from PC to PC, knowing they can always access their information by simply 
synchronizing with the team repository and setting their profile as active.
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Active ProfilesActive Profiles

When creating connections and filter 
pools you must specify the active profile to 
contain the new connection or profile
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We see now why both the connection and the filter pool 
wizards contain a dropdown for selecting the target profile.
These both default to the first non-team active profile.
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Active ProfilesActive Profiles

Connections and 
filter pools can be 
copied or moved to 
other profiles

11

11

22

22
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Here we seen how we can use the copy and move actions to 
move information between profiles.
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Work With Filter PoolsWork With Filter Pools

For one-stop shopping for working with 
filter pools, select Work With->Filter Pools 
from subsystem popup menu

You must be in "Show filter pools" modeYou must be in "Show filter pools" mode

Filter pool actionsFilter pool actions

Active profilesActive profiles

Filter Pools per Filter Pools per 
profileprofile
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Finally, now we can return to the topic of Filter Pools to finish it.
There is a handy Work With Filter Pools action per subsystem that allows working with all the 
filters pools in all the active profiles, from one dialog. 
In this dialog, you will see all the filters pools within each active profile. From here you can create, 
rename, copy, move and delete filter pools.
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Remote Systems ExplorerRemote Systems Explorer

Underlying Model of RSE
Profiles

contain

Filter Pools

contain
Filters

contain

contain

Connections

contain
contain

Subsystems
Filter Pool 

References 

Filter Strings

User Defined Actionscontain

Profiles Profiles 
enable enable 
team team 
support support 
and and 
effective effective 
groupinggrouping

reference
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This is an architecture chart showing the underlying model of all the 
information that the RSE maintains. 
For those with an architectural bent, this may help you to visualize all the 
pieces we have been talking about.
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iSeries ProjectsiSeries Projects

2.2. iSeries ProjectsiSeries Projects
A special project type

For holding source destined to be compiled on iSeriesFor holding source destined to be compiled on iSeries

A dedicated perspective
For working with all, and only, iSeries projectsFor working with all, and only, iSeries projects
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This concludes the RSE part of the presentation.
Now it is time to turn our attention to the second major area of support for RPG and COBOL programmers in WDSc. 
This is the iSeries projects support. 
There is a special project type designed to hold source that is destined to be compiled and run on an iSeries. There is 
a wizard for creating a new iSeries Project.
There is a special perspective for working with iSeries projects. 
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iSeries ProjectsiSeries Projects

iSeries Project Wizard
For creating iSeries projects

What is an iSeries project?
Typical Eclipse projectTypical Eclipse project

Contains folders and files,  can be shared by a teamContains folders and files,  can be shared by a team
Can have its own tools and perspectivesCan have its own tools and perspectives

But alsoBut also
Holds copies of some source members from an iSeries libraryHolds copies of some source members from an iSeries library
Those copies are "pushed" up occassionally and the project Those copies are "pushed" up occassionally and the project 
re-builtre-built
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An iSeries Project is a typical Eclipse project. This means it contains folders and files that are in the 
local file system of the IDE, but these can be synchronized with a central repository for team support.
Since the files are local, there is actions to support "pushing" those files up to an iSeries library, 
where they become source members. This is done prior to compiling or "building" the source for the 
purpose of testing.
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iSeries ProjectsiSeries Projects

Use Use File->NewFile->New  
to launch to launch 

iSeries ProjectiSeries Project
Wizard Wizard 

iSeries iSeries 
ProjectProject
Wizard Wizard 
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Here we see how to create a new iSeries project, using the File menu's New 
menu item. Select iSeries and then iSeries Project, and press Next.
This can be launched from any perspective, but will switch you to the iSeries 
Projects perspective after creating the project.
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Give your Give your 
project a project a 

namename

Choose Choose 
connection connection 

from RSE listfrom RSE list

Identify Associated Identify Associated 
Library: this is the target Library: this is the target 

library for pushes and library for pushes and 
buildsbuilds

Identify Identify 
command to command to 
call for Build call for Build 

action action 

iSeries ProjectsiSeries Projects iSeries iSeries 
ProjectProject
Wizard Wizard 
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Here we see the rest of the iSeries Project wizard.
First, give the project a name. Any name you want!
Then select or create a connection (from the RSE!) that identifies the iSeries with which this project is associated. Also 
select the library on that iSeries where the contents of this project will be pushed to.
Also, specify a CL command to call for the "Build" action. If you don't have such a CL command, enter a dummy value 
or leave it blank.
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iSeries ProjectsiSeries Projects

Dedicated Perspective for iSeries Projects

Reserved Reserved 
for Editorfor Editor

iSeries Project iSeries Project 
navigatornavigator: expand : expand 

project to work project to work 
with local sourcewith local source

Create iSeries Create iSeries 
ProjectProject

Create Create 
Source FileSource File

Create Source Create Source 
MbrMbr

iSeries iSeries 
Projects Projects 

PerspectivePerspective

Remote Systems Remote Systems 
view for view for 

convenienceconvenience

WDT400 Page (68)

Here we see the iSeries Projects perspective, which you can explicitly open.
The primary view is the iSeries Navigator that allows exploration of all existing iSeries Projects. 
There are wizards lauchable from the toolbar for creating a new iSeries Project, or creating source physical files and source members within 
an existing project.
The iSeries Projects perspective includes a full copy of the Remote Systems Explorer, as a view, for your convenience. This allows you to 
easily work with the contents of the associated library while simultaneously working with the local copies of the source within the project.
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iSeries ProjectsiSeries Projects

iSeries File Wizard
For creating files in your iSeries project

Specify attributes that are Specify attributes that are 
used when file is finally used when file is finally 

created in associated librarycreated in associated librarySelect Select 
ProjectProject

New File New File 
WizardWizard

Source File = a folder in your projectSource File = a folder in your project
Until you "Push" your changes. Until you "Push" your changes. 
Then a CRTSRCPF is doneThen a CRTSRCPF is done

iSeries FileiSeries File
Wizard Wizard 

WDT400 Page (69)

Here we see the wizard for creating a new iSeries source physical file. Within 
the project, this is actually a folder. When the project is pushed to its 
associated library, this result in a CRTSRCPF command being run to create a 
file with the attributes specified in this wizard.
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Select the parent Select the parent 
folder. folder. 

New Mbr New Mbr 
WizardWizard

Member = a file in your folderMember = a file in your folder
Until you "Push" your changes. Until you "Push" your changes. 
Then an ADDPFM is doneThen an ADDPFM is done

iSeries Member Wizard
For creating mbrs in your iSeries project

Name the member: Name the member: 
name.typename.type

iSeries iSeries 
MemberMember
Wizard Wizard 
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Here we see the wizard for creating a new iSeries source member within an iSeries project. Actually, it 
is within a source phyical file (aka folder) within an iSeries project.
Locally, a member is really a file on disk. The file's extension is the member's type, as in ABC.RPGLE. 
When this project is pushed to its associated library, this will result in an ADDPFM command being run 
to create the file with the name and type, in its parent file.
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What about existing members?
Use Add to Project action to copy them

Right click on project, select "Show Remote Objects"Right click on project, select "Show Remote Objects"
Drill down to source file, right click, select "Add to Project"Drill down to source file, right click, select "Add to Project"
Drill down to members, right click, select "Add to Project"Drill down to members, right click, select "Add to Project"

Files added become folders locally
Members added are copied to that folder
Developer works on local copy 

Edits fileEdits file
Pushes changes using "Push" actionPushes changes using "Push" action
Does a build using "Build" actionDoes a build using "Build" action
Shares with team using "Synchronize" actionShares with team using "Synchronize" action

Full power of Eclipse at disposal
Team supportTeam support
Marker/bookmark supportMarker/bookmark support
Editor registraction support ...Editor registraction support ...
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Often, you won't be creating new files and members from scratch, but rather working with existing files and members.
You can import these from your associated library into your iSeries project. The files become local folders, while the members become local files within a local folder. 
To import, you have to first select the "Show Remote Objects" menu item from the project's popup menu. This will show the contents of the project's associated library in the iSeries 
Navigator view. You can select files or members, and right click on them to select their "Add to Project" action. This will copy them down to the local project.
Once files and members have local copies in the project, you can edit and work with them locally, and when ready push them back to the library where they can be compiled and run.
An iSeries project inherits all the capabilities of an Eclipse project, includes support for teams, for persistent markers and bookmarks, and for registering your favourite editor per file 
extension. The latter can't be done for the Remote Systems Explorer, as only editors capable of working on remote source are valid. But for iSeries projects, the source is a local file 
so any editor can be used. 
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iSeries Project PerspectiveiSeries Project Perspective

Project "Bleedthrough"Project "Bleedthrough"
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Here we see an iSeries project in the iSeries Navigator, within the iSeries 
Projects perspective, that has a number of local files and members.
Right-clicking on the project or anything in the project, gives a popup menu 
with the all-important "Show Remote Objects" menu item.... 
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iSeries ProjectsiSeries Projects

(Remote) => (Remote) => 
only exists in associated libraryonly exists in associated library

(Local/Remote) =>(Local/Remote) =>
exists locally and in associated libexists locally and in associated lib

(Local/Remote) =>(Local/Remote) =>
conflict between local and remoteconflict between local and remote

otherwise =>otherwise =>
only exists locallyonly exists locally

iSeries Project navigator:iSeries Project navigator:
local files and memberslocal files and members

Use PushPush popup menu action 
to copy from project to library
Use BuildBuild to build project
Use Team->SyncTeam->Sync to copy 
to/from team repository

remote objects, files and mbrsremote objects, files and mbrs
Use Add to ProjectAdd to Project to copy 
from library to project
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Once "Show Remote Objects" is enabled (it is a toggle) all the objects in the associated library for this project are shown in the iSeries Navigator.
This navigator is called a "bleed through" view because it lists both local files/members and remote objects, files and members. However, if a file 
or member exists both locally and remotely, it is not shown twice. Rather, it is only shown once, and its icon and bracketed text identify it as 
existing in both places.
The icons and text enable you to see at a glance which files/members exist only locally, only remotely, or both locally and remotely. In the latter 
case, the color of the icon indicates if the two are in synch or not. If not, it is an indication you need to "push" your local source to the associated 
library to get it in synch. 
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Lpex editor for local members or choose favorite editorLpex editor for local members or choose favorite editor

Remote Systems Remote Systems 
Explorer to work Explorer to work 
with objects in with objects in 
remote libraryremote library

Property Sheet to Property Sheet to 
show properties show properties 
of selected local of selected local 
or remote objector remote object
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With the local copies of members, you can edit them using the Lpex or CODE editor, or editor of your choice. When a local or 
remote object is selected, you see important properties of it in the Properties view. 
When editing is complete, right clicking on the project or anything in the project offers actions to push the changed source 
members to the associated library, and run the build command to compile those changes (if you supplied such a command)
To work on remote objects, use the Remote Systems view that is also in the iSeries Projects perspective. For example, if you 
do not have a build command, then use the RSE to compile your remote source member after pushing it.
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Using projects

Team 
Repository

Dev1 Lib Dev2 Lib Dev3 Lib

Prod Lib

Test Lib

library list library list library list

Dev1 IDE Dev2 IDE Dev3 IDE

push
build

push
build

push
build

team 
sync

team 
sync

team 
sync

Projects typically hold small delta
Eg: Files necessary to implement new featureEg: Files necessary to implement new feature

Each developer can have unique ass'd lib
Eg: For private buildsEg: For private builds
Use team synch to pick up colleague's work so farUse team synch to pick up colleague's work so far
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The typical usage scenario for iSeries projects is to use them for tasks, such as adding a feature to an existing application.
Rarely will you use an iSeries project to hold all the source for an application... use an iSeries change management vendor for that. 
Consider a change that involves 3 developers changing a number of files...
The lead developer will create the iSeries project and synchronize it with the repository. The other developers will use the Eclipse team support to add that project to their workspace. Each will change the properties 
of the project to associate it with their own private library. The master library containing all the source will be on their library list, so compiles will work, but their private library will only hold the members they work on. 
If they use an SCM product, then they will use it to check source members out to their private library. These members and files will then be imported into their project, where they will edit them.
After editing, they will "push" their changes to their library and do a "Build" or a compile, and run and test their unique changes.
Every so often, they will do a team synchronization to give their changes to their fellow team members, and pick up the changes of those team members. After a synch, they will push their colleaque's files to their 
own associated library and test the changes all work together.
At the end of the cycle, someone will pick one of the libraries, and use the SCM product to promote their changes back into the test and production stages.
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Stay tuned...
iSeries Projects are new, and their 
functionality is still immature

They are offered initially to gather feedback so They are offered initially to gather feedback so 
they can subsequently be optimized to best match they can subsequently be optimized to best match 
your development patternsyour development patterns

The support for iSeries project will 
iterate quickly in coming releases

Including much better integration support for Including much better integration support for 
iSeries change management vendors such as iSeries change management vendors such as 
Aldon, MKS and SoftLanding.Aldon, MKS and SoftLanding.
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iSeries projects are young technology!
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More Information?More Information?

Information Sources
www.ibm.com/software/ad/iseries

Portal for WDScPortal for WDSc
www.eclipse.org

Eclipse and information about eclipseEclipse and information about eclipse
www.ignite400.org

Introduction to eclipse articleIntroduction to eclipse article
eServer iSeries magazine, July issue

3 articles on WDSc3 articles on WDSc
www.ibm.com/websphere/developer

WebSphere Developer DomainWebSphere Developer Domain
Many articles and tutorials on technology and tools, Many articles and tutorials on technology and tools, 
including eclipse and WSWB and WebSphere Studio including eclipse and WSWB and WebSphere Studio 
configurationsconfigurations
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Where to get more information
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